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General DITA, Reuse, Tasks and Illustrations
Introducing this range of topics.

Topics:

• Common DITA testing
• Reuse and task testing
• Illustration and video testing

I
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Common DITA testing
This chapter contains the following sections:

Topics:

• General text tests
• Paragraph elements (first-level heading)
• Common inline elements
• Unordered list element
• Ordered list element
• Definition list element
• Simple list element
• Programming elements
• Software elements
• User interface elements

General text tests
This section tests the following DITA elements:

● Paragraphs
● Titles (at various levels)
● Section titles
● Admonitions
● Footnotes (in regular text)

Paragraph elements (first-level heading)
A paragraph element (<p>) is a block of text containing a single main idea.

The oldest classical Greek and Latin writing had little or no spaces between words or other ones, and could be written in
boustrophedon (alternating directions). Over time, text direction (left to right) became standardized, and word dividers and
terminal punctuation became common. The first way to divide sentences into groups was the original paragraphos, similar to an
underscore at the beginning of the new group. The Greek paragraphos evolved into the pilcrow, which in English manuscripts in
the Middle Ages can be seen inserted inline between sentences. The hedera leaf has also been used in the same way.

In ancient manuscripts, another means to divide sentences in into paragraphs was a line break (newline) followed by an initial at
the beginning of the next paragraph. An initial is an oversize capital letter, sometimes outdented beyond the margin of text. This
style can be seen, for example, in the original Old English manuscript of Beowulf. Outdenting is still used in English typography,
though not commonly. Modern English typography usually indicates a new paragraph by indenting the first line. This style can be
seen in the (handwritten) United States Constitution from 1787. For additional ornamentation, a hedera leaf or other symbol can
be added to the inter-paragraph whitespace, or put in the indentation space.

A second common modern English style is to use no indenting, but add vertical whitespace to create "block paragraphs." On a
typewriter, a double carriage return produces a blank line for this purpose; professional typesetters (or word processing
software) may put in an arbitrary vertical space by adjusting leading. This style is very common in electronic formats, such as on
the World Wide Web and email.

Special Characters - Section title (under first-level heading)

Here is a list of special characters, used to test character-encoding when it was inappropriately changed to Windows 1252 from
UTF-16. Each character in the next paragraph is separated by a space.

1
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Note element and admonitions (second-level heading)

A <note> element contains information, differentiated from the main text, which expands on or calls attention to a particular
point. Variant types of note (tip, caution, danger, warning, etc.) can be indicated through values selected on the type attribute.

In United States safety standards, precautionary statements are sentences providing information on potential hazards, and
proper procedures.

NOTE: A note identifies information that is incidental, but not essential, to the topic. Notes can provide explanation, a

comment, reinforcement of a point in the text, or just a related point. (the following unordered list is included in this note.)

● Use notes sparingly. Too many notes on a page often indicate an organizational problem, clutter a page, and confuse the

reader.

● Keep notes short and relevant. Usually, notes don't contain thinks like UIControls (but this one does)

● Do not confuse notes with other types of admonitions. Never use a note to cite safety information.

Deprecated admonition types - section title (under second-level heading)

WARNING: Warning statements are a description of a potentially hazardous situation which if not avoided could

result in minor personal injury or serious injury or death.

CAUTION: Caution statements are a description of a potentially hazardous situation which if not avoided could

result in minor personal injury or serious injury or death.

There are other types on notes available in DITA but not supported by Dell. These note types should appear as standard "Note"
notes.

NOTE: Danger statements are a deprecated description of an imminent hazard that will result in severe injury or death if

not avoided and should be limited to the most extreme situations.

NOTE: Notice statements are a deprecated type formerly used to notify people on hazards that could result in things other

than personal injury, like property damage.

NOTE: This is an "Important" note.

NOTE: This is a "Tip" note.

NOTE: This is an "Attention" note.

NOTE: This is a "Fastpath" note.

NOTE: This is a "Remember" note.

NOTE: This is a "Restriction" note.

NOTE: This is an "Other" note with "Something Else" for the othertype attribute.

Example elements (third-level heading)

The <example> element is a section with the specific role of containing examples that illustrate or support the current topic.

The first example provides a sample of an example that omits the title.

The following configuration permits all packets (both fragmented and non-fragmented) with destination IP 10.1.1.1. The second
rule does not get hit at all.

Dell(conf)#ip access-list extended ABC
Dell(conf-ext-nacl)#permit ip any 10.1.1.1/32
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Dell(conf-ext-nacl)#deny ip any 10.1.1.1./32 fragments
Dell(conf-ext-nacl)

To deny the second/subsequent fragments, use the same rules in a different order. These ACLs deny all second and subsequent
fragments with destination IP 10.1.1.1 but permit the first fragment and non-fragmented packets with destination IP 10.1.1.1.

Example of Denying Second and Subsequent Fragments

Dell(conf)#ip access-list extended ABC
Dell(conf-ext-nacl)#deny ip any 10.1.1.1/32 fragments
Dell(conf-ext-nacl)#permit ip any 10.1.1.1/32
Dell(conf-ext-nacl)

Section title (under a third-level heading)

The second example is an example element that includes a title.

Examples of Configuring PIM-Sparse Mode

The following example shows how to enable PIM multicast routing on the VLT node globally.

VLT_Peer1(conf)#ip multicast-routing

The following example shows how to enable PIM on the VLT port VLANs.

VLT_Peer1(conf)#interface vlan 4001
VLT_Peer1(conf-if-vl-4001)#ip address 140.0.0.1/24
VLT_Peer1(conf-if-vl-4001)#ip pim sparse-mode
VLT_Peer1(conf-if-vl-4001)#tagged port-channel 101
VLT_Peer1(conf-if-vl-4001)#tagged port-channel 102
VLT_Peer1(conf-if-vl-4001)#no shutdown
VLT_Peer1(conf-if-vl-4001)#exit

The following example shows how to configure the VLTi port as a static multicast router port for the VLAN.

VLT_Peer1(conf)#interface vlan 4001
VLT_Peer1(conf-if-vl-4001)#ip igmp snooping mrouter interface port-channel 128
VLT_Peer1(conf-if-vl-4001)#exit
VLT_Peer1(conf)#end

The following example shows how to repeat these steps on VLT Peer Node 2.

VLT_Peer2(conf)#ip multicast-routing

VLT_Peer2(conf)#interface vlan 4001
VLT_Peer2(conf-if-vl-4001)#ip address 140.0.0.2/24
VLT_Peer2(conf-if-vl-4001)#ip pim sparse-mode
VLT_Peer2(conf-if-vl-4001)#tagged port-channel 101
VLT_Peer2(conf-if-vl-4001)#tagged port-channel 102
VLT_Peer2(conf-if-vl-4001)#no shutdown

VLT_Peer2(conf-if-vl-4001)#ip igmp snooping mrouter interface port-channel 128
VLT_Peer2(conf-if-vl-4001)#exit
VLT_Peer2(conf)#end

Lines, quote and other elements (fourth-level heading)

The <lines> element can be used to represent dialogs or text fragments where line breaks are significant. The <lines> element is
similiar to <pre> in that hard line breaks should be preserved, but the font style is not set to monospace, and extra spaces inside
the lines are not preserved.

This is a sample of my favorite sonnet.

Shall I compare thee to a summer's day?
Thou art more lovely and more temperate:
Rough winds do shake the darling buds of May,
and summer's lease hath all too short a date:
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Sometimes too hot the eye of heaven shines,
And often is his gold complexion dimm'd;
And every fair from fair sometimes declines,
By chance or nature's changing course untrimm'd
But thy eternal summer shall not fade,
Nor lose possession of that fair thou ow'st;
Nor shall Death brag thou wander'st in his shade,
So long as men can breathe or eyes can see,
So long lives this, and this gives life to thee.

One reviewer of Shakespeare's poem helps us demonstrate the <q> element, he provides this analysis of the poem. "Attempts
to justify the speaker 's beloved's beauty by comparing it to a summer's day, and comes to the conclusion that his beloved is
better after listing some of the summer's negative qualities."

A few other text-based elements - section title under fourth-level heading

Here are a few other text elements that you might encounter:

Abraham Lincoln was the 16th President of the United States, he provides a long quote (in the form of the <lq> element) for
instance

Four score and seven years ago our fathers brought forth on this continent a new nation, conceived in liberty, and dedicated to
the proposition that all men are created equal.

Lincoln served from March 1861 until his assasination in April 1865.

You might see a draft comment below (between this paragraph and the next), if draft-comments are turned on ...

This content is located inside a <sectiondiv> element, which allows logical grouping of content within a section. There is no
additional meaning associated with a sectiondiv element, aside from its function as a container for other content. sectiondiv

Common inline elements
Inline elements are important because they help the user distinguish between normal text and special text.

Cite

The online article Specialization in the Darwin Information Typing Architecture provides a detailed explanation of how to define
new topic types.

Footnote

Use the footnote1 element to annotate text2 with notes that are inappropriate for inline inclusion or to indicate the source for
facts or other material used in the text.

Keyword

This is a keyword element. The keyword element identifies a keyword or token2, such as a single value from an enumerated list,
the name of a command or parameter, product name, or a lookup key for a message.

Phrase

This is a phrase element. This element is used to organize content for reuse or conditional processing.2

1 This is a single-use footnote
2 This is a multi-use footnote
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Superscript and subscript

The power produced by the hydroelectric dam was 1010 more than the older electric plant. The difference was H2O.

Term

The term element identifies words that might have or require an extended definition or explanation. The reference
implementation of DITA represents the standard, fallback behaviors intended for DITA elements.

Trademarked term

This is a trademarked term: EMC™.

This is a a registered trademark: Starbucks®

Inline quote: <q>

"This is an inline quote." This element indicates content quoted from another source. This element is used for short quotes
which are displayed inline.

Unordered list element
In an unordered list (<ul>), the order of the list items is not significant. List items are typically styled on output with a "bullet"
character, depending on nesting level.

This is a paragraph with some text before the unordered list.

● This is the first list item.
● This another list item with several levels of nested sub items.

○ Second level item 1
○ Second level item 2

￭ Third level item 1
￭ Third level item 2

- Fourth level item 1
- Fourth level item 2
- Fourth level item 3

￭ Third level item 3
○ Second level item 3

● This list item has a lot of information and requires multiple paragraphs to fully describe everything that is trying to be
expressed.

The second paragraph of a long unordered list item.

This paragraph contains additional information in a paragraph after the list.

Ordered list element
In an ordered list (<ol>), the order of the list items is significant. List items are typically styled on output with a "numeric or
alpha" character, depending on nesting level.

This is a paragraph with some text before the ordered list.

1. This is the first list item.
2. This another list item with several levels of nested sub items.

a. Second level item 1
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b. Second level item 2

i. Third level item 1
ii. Third level item 2

i. Fourth level item 1
ii. Fourth level item 2
iii. Fourth level item 3

iii. Third level item 3
c. Second level item 3

3. This list item has a lot of information and requires multiple paragraphs to fully describe everything that is trying to be
expressed.

The second paragraph of a long ordered list item.

This paragraph contains additional information in a paragraph after the list.

Definition list element
A definition list (<dl>) is a list of terms and corresponding definitions.

A sailboat or sailing boat is a boat propelled partly or entirely by sails smaller than a sailing ship.

Sloop The most common modern sailboat is the sloop, which features one mast and two sails, typically a
Bermuda rigged main, and a headsail.

A fractional rigged sloop has its forestay attached at a point below the top of the mast, allowing the
mainsail to be flattened to improve performance by raking the upper part of the mast aft by tensioning
the backstay.

Cutter The cutter is similar to a sloop with a single mast and mainsail, but generally carries the mast further aft
to allow for a jib and staysail to be attached to the head stay and inner forestay, respectively.

Multi-mast
sailboats

Sailboats with two or more masts are multi-mast boats.

Ketch Ketches are similar to a sloop, but there is a second shorter mast astern of the
mainmast, but forward of the rudder post.

Historical ketch
rigs

The square-rigged ketch was largely supplanted by the brig,
which differs from the ketch by having a forward mast
smaller (or occasionally similar in size) than the after mast,
and by the hoy, which was fore-and-aft rigged.

Barquentine A Barquentine (also spelled
barkentine) is a sailing vessel with
three or more masts; with a square-
rigged foremast and fore-and-aft
rigged main, mizzen, and any other
masts.

Brigantine A Brigantine is a vessel with two
masts, only the forward of which is
square-rigged.

Experiment The Experiment of Newburyport
weighed 114 tons and was built in
Amesbury in 1803.

Columbia The steamship Columbia was an
example of a late 19th century
auxilliary brigantine rig vessel.

Modern ketch
rigs

On a ketch, the principal purpose of the mizzen sail is to help
propel the vessel, while on a yawl, the smaller mizzen mainly
serves the purposes of trim and balance.
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Yawl A yawl is similar to a ketch, with a shorter mizzen mast carried astern the
rudderpost more for balancing the helm than propulsion.

Distinctions in what constitutes a sailing boat and ship vary by region and maritime culture.

Simple list element
The <sl> element contains a simple list of items of short, phrase-like content, such as a list of materials in a kit or package.
Simple list output should have no bullets, on the assumption that each item is short enough to fit on one line, and needs no
additional differentiation from its neighbors.

Messages from the ags_open module are identical with messages from:

ags_read
ags_write
ags_close

This paragraph contains additional information after the list.

Programming elements
These elements represent the programming domain.

Here is an example of an apiname element.

Here is an example of the option element.

Here is an example of the keyword element.

Here is an example of the varname element

Here is an example of the parmname element

Here is an example of the synph element

Here is an example of the ...
Parameter term <pt> in a <parml>

Parameter definition<pd> in a <parml>

...element.

Here is an example of a syntax diagram ...

CopyFile

Some random paragraph of text before a codeblock.

var fibonacci_series = function (n) {  
  if (n===1) {  
    return [0, 1];  
  }   
  else {  
    var s = fibonacci_series(n - 1);  
    s.push(s[s.length - 1] + s[s.length - 2]);  
    return s;  
  }  
};

The following codeblock contains some long lines and has the outputclass attribute set to "pagewide".

<xsl:template match="*[contains(@class,' sw-d/varname ')]">
    <fo:inline xsl:use-attribute-sets="varname">
      <xsl:call-template name="commonattributes"/>
      <xsl:choose>
        <xsl:when test="parent::*[contains(@class,' ui-d/uicontrol ') or 
contains(@class,' pr-d/var ')]">
          <xsl:apply-templates/>
        </xsl:when>
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        <xsl:otherwise>
          <xsl:call-template name="insertVariable">
            <xsl:with-param name="theVariableID" select="'start-quote'"/>
          </xsl:call-template>
          <xsl:apply-templates/>
          <xsl:call-template name="insertVariable">
            <xsl:with-param name="theVariableID" select="'end-quote'"/>
          </xsl:call-template>
        </xsl:otherwise>
      </xsl:choose>
    </fo:inline>
  </xsl:template>

More random paragraph text after the codeblock

Software elements
Software elements include varname, msgph, cmdname, filepath, userinput, and systemoutput.

Software elements

This is a varname element. The variable name varname element defines a variable that must be supplied to a software
application. The variable name element is very similar to the variable (var) element, but variable name is used outside of syntax
diagrams.

Msgph

This is a msgph element. The message phrase (<msgph>) element contains the text content of
a message produced by an application or program. It can also contain the variable name
(varname) element to illustrate where variable text content can occur in the message.

Cmdname

This is a cmdname element. The command name element specifies the name of a command when it is part of a software
discussion.

Filepath

This is a filepath element. The filepath element indicates the name and optionally the location of a referenced file by
specifying the directory containing the file, and other directories that may precede it in the system hierarchy.

Userinput

This is a userinput element. The user input element represents the text a user should input in response to a program or
system prompt.

Systemoutput

This is a systemoutput element. The system output systemoutput element represents computer
output or responses to a command or situation. A generalized element, it represents any
kind of output from the computer, so the author may wish to choose more specific markup,
such as msgph, for messages from the application.
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User interface elements
A reference to the various user interface elements available in DITA.

Menucascade with uicontrols

Here's an example of a menucascade with a uicontrol or two embedded in it.

1. To open a new file, navigate to File > Open
2. Select the correct file from the file list and click Ok

Wintitle

Here's an example of wintitle used in context.

1. To create a content reference, choose SDL Tridion Docs > Conref > Insert conref....
2. The Insert Conref window displays

Shortcut

Here's an example of the shortcut element used in context.

1. To copy and paste, navigate to the source location and highlight the source text.
2. Click Copy (Ctrl+C) to copy and Paste (Ctrl+V) to paste.

Screen

Here's an example of a text based screen. Rarely used these days. The example is a git bash log.

tdill@USENTDILLL5C MINGW64 /c/views/MERGED_DITA_OT (tridionProduction)
$ git log -4
commit 1073d6cba58f03bd01fd4282c6e490bd677c5f85 (HEAD -> tridionProduction)
Merge: 3f9d819a ba3134ea
Author: Veda Phani Swaroop.Hari <veda.phani.swaroop.hari@dell.com>
Date:   Thu Jul 2 18:52:55 2020 +0530

    Merge Irina's changes from 'xhtml_idpl-11835_idpl-11836-reltables' into 
tridionProduction

commit 3f9d819a9b66b9ef9937c222a4a253b2cd82d700
Merge: f6eee6dc e859419c
Author: Veda Phani Swaroop.Hari <veda.phani.swaroop.hari@dell.com>
Date:   Thu Jul 2 18:41:41 2020 +0530

    Merge Irina's changes from 'webhelp-idpl-11834-reltables' into tridionProduction

commit f6eee6dca1bf710c3dc5dc7715072d05bc646316
Merge: 8a117ad0 7be1df2a
Author: Tom Dill <tom.dill@dell.com>
Date:   Wed Jul 1 18:00:03 2020 -0400

    Merge Irina's changes from 'pdf-idpl-11479-reltables' into tridionProduction

commit 8a117ad026b12c2cb050d319ffdcb7da87a6ab4a
Merge: de317cb3 1e47911d
Author: Tom Dill <tom.dill@dell.com>
Date:   Wed Jul 1 17:54:44 2020 -0400
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Reuse and task testing
This chapter contains the following sections:

Topics:

• Conref testing
• Keyref and conkeyref testing
• More about Dell EMC VMax features
• Repairs ... using variables for reuse

Conref testing
a content reference or conref is a mechanism designed to allow reuse between various topics. This topic with some of the other
topics in this chapter, demonstrate the proper use of conrefs.

This topic tests how conrefs work in a document.

Follow these steps before you work on any equipment:

● Turn off the system and all attached peripherals.
● Disconnect the system and all attached peripherals from AC power, and then remove the battery.
● Disconnect all network cables, telephone or telecommunications lines from the system.
● Use a wrist grounding strap and mat when working inside any computer system to avoid electrostatic discharge (ESD)

damage.
● After removing a system component, carefully place the removed component on an anti-static mat.
● Wear shoes with non-conductive rubber soles to help reduce the risk of being shocked or seriously injured in an electrical

accident.

The following illustration shows you how to bond yourself properly, to reduce damage that might occur from static electicity.

Figure 2. Bonding Properly

Other key precautions include:

Electrostatic Discharge Protection

ESD is a major concern when you handle electronic components, especially sensitive components such as expansion cards,
processors, memory DIMMs, and system boards. Very slight charges can damage circuits in ways that may not be obvious, such
as intermittent problems or a shortened product life span. As the industry pushes for lower power requirements and increased
density, ESD protection is an increasing concern.

2
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Due to the increased density of semiconductors used in recent Dell products, the sensitivity to static damage is now higher than
in earlier Dell products. For this reason some previously approved methods of handling parts are no longer applicable.

There are two recognized types of ESD damage: catastrophic and intermittent failures.

● Catastrophic —The damage causes an immediate and complete loss of device functionality. An example of catastrophic
failure is a memory DIMM that has received a static shock and immediately generates a "No POST/No Video" symptom with
a beep code emitted for missing or nonfunctional memory.

NOTE: Catastrophic failures represent approximately 20 percent of ESD-related failures.

● Intermittent —The DIMM receives a static shock, but the tracing is merely weakened and does not immediately produce
outward symptoms related to the damage. The weakened trace may take weeks or months to melt, and in the meantime may
cause degradation of memory integrity, intermittent memory errors, etc.

NOTE: Intermittent failures represent approximately 80 percent of ESD-related failures. The high rate of intermittent

failures means that most of the time when damage occurs, it is not immediately recognizable.

The more difficult type of damage to recognize and troubleshoot is the intermittent (also called latent or “walking wounded”)
failure. The following image shows an example of intermittent damage to a memory DIMM trace. Although the damage is done,
the symptoms may not become an issue or cause permanent failure symptoms for some time after the damage occurs.

Figure 3. Intermittent (Latent) Damage to a Wiring Trace

Do the following to prevent ESD damage:

● Use a wired ESD wrist strap that is properly grounded.

The use of wireless anti-static straps is no longer allowed; they do not provide adequate protection.

Touching the chassis before handling parts does not ensure adequate ESD protection on parts with increased sensitivity to
ESD damage.

Figure 4. Chassis "Bare Metal" Grounding (Unacceptable)

● Handle all static-sensitive components in a static-safe area. If possible, use anti-static floor pads and workbench pads.
● When handling static-sensitive components, grasp them by the sides, not the top. Avoid touching pins and circuit boards.
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● When unpacking a static-sensitive component from its shipping carton, do not remove the component from the anti-static
packing material until you are ready to install the component. Before unwrapping the anti-static packaging, be sure to
discharge static electricity from your body.

● Before transporting a static-sensitive component, place it in an anti-static container or packaging.

More information

for more refer to the following Getting Started Guide available at www.dell.com/poweredgemanuals

Accessing the latest release notes

Here we use conref ranges to access a set of steps from several sets in a conref file.

About this task

To access the latest Release Notes for this version of iDRAC:

Steps

1. Go to https://www.dell.com/idracmanuals

2. Click the link for the generation and then click the version of iDRAC.

3. Click Manuals & documents.

Results

This takes you to the release notes page for iDRAC.

Accessing documents by selecting your product

You can access documents by selecting your product from the support website. Here's how.

Prerequisites

In order to know how to access documents this way, you must know your products name and category.

Steps

1. Go to https://www.dell.com/support.

2. Click Browse all products.

3. Click the desired product category, such as Servers, Software, Storage, and so on.

4. Click the desired product then click the desired version if applicable.

NOTE: For some products, you may need to navigate through the subcategories.

5. Click Manuals & documents.

Results

This area contains all of the manuals and documents associated with your product.

Keyref and conkeyref testing
A keyref is a mechanism that allows short text- or link-based content to be abstracted from a particular topic and added to a
replaceable map, which allows quick replacement of that topic's content and hrefs based on which map is included in the DITA
structure. Conkeyref is a conref that is based on a key stored in a map that manages dynamically what the source of the conref
will be. The next few topics illustrate the use of keyrefs and conkeyrefs for adding text replacements, href links and image
replacements.

NOTE: The keyrefs used in this document are located in the map file named "qa_m_test_bed_dell_emc_keydef"
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The Dell EMC VMax Engineering team has used their expertise to solve the CIO challenge of embracing a modernized flash-
centric datacenter for mission-critical applications while simultaneously simplifying, automating, and consolidating IT operations.
The benefits of the VMax include the following:

● Broadwell CPUs yielding 48 cores per engine
● Up to 64 FE ports per system
● Up to 1 PBe capacity per system
● Open Systems and/or mainframe support

The image above is based on a keyref that manages what image will display, from the map.

Dell EMC works together with these sister companies to achieve maximum benefit for our customers:

● Dell
● Secureworks
● Virtustream
● VMware

More about Dell EMC VMax features
The features of the VMax work together to achieve our goal, which is to solve the CIO challenge of embracing a modernized
flash-centric datacenter for mission-critical applications while simultaneously simplifying, automating, and consolidating IT
operations. The sections below are added using conkeyrefs.

Broadwell CPUs yielding 48 cores per engine

The brick engine uses a core pooling mechanism which can dynamically load balance the cores by distributing them to the front
end, back end, and data services running on the engine (such as SRDF, eNAS, and embedded management). The core pools can
be dynamically tuned to shift the bias of the pools at any time to front-end heavy or back-end heavy workloads to further
optimize the solution for a specific use case.

Up to 64 FE ports per system

Up to 64 ports of front end (FE) connectivity for the VMAX.

Up to 1 PBe capacity per system

Dell EMC uses PBu (and TBu) to define usable storage capacity in the absence of compression, referring to the amount of
usable physical storage in the box. Dell EMC uses PBe (and TBe) to define effective storage capacity in the presence of
compression. For example, if a customer has 50 TBu of physical storage, and it is compressible on a 2:1 basis, then the customer
has 100 TBe (effective storage).

Open Systems and/or mainframe support

Achieve massive consolidation with support for mixed open, mainframe, IBM i, and file storage on the same system simplifying
management and significantly lowering overall TCO.
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Repairs ... using variables for reuse
This topic illustrates the use of variables to insert text in various locations.

Prerequisites

CAUTION: Many repairs may only be done by a certified service technician. You should only perform

troubleshooting and simple repairs as authorized in your product documentation, or as directed by the online or

telephone service and support team. Damage due to servicing that is not authorized by Dell is not covered by

your warranty. Read and follow the safety instructions that came with the product.

1. Turn off the system and attached peripherals, and disconnect the system from the electrical outlet.
2. Remove the system cover.

About this task

Ensure the voltage selector switch on the power supply is set correctly. The voltage selector switch is available only on non-EPA
power supplies.

Steps

1. Remove the following components from the system:

● hard drives
● hard-drive backplane
● USB memory key
● hard-drive tray
● cooling shroud
● expansion-card risers (if present)
● expansion cards
● power supply unit(s)
● cooling-fan assembly (if present)
● cooling fans
● processor(s) and heat sink(s)
● memory modules

2. Let the system dry thoroughly for at least 24 hours.

3. Reinstall the components you removed in step 3.

4. Install the system cover.

5. Turn on the system and attached peripherals.

If the system does not start properly, try, try again.

6. If the system starts properly, shut down the system, and reinstall all the expansion cards that you removed.

7. Run the appropriate diagnostic test.

Next steps

If the tests fail, try some more.
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Illustration and video testing
This chapter contains the following sections:

Topics:

• Vector graphics in figures
• Low-resolution screenshots in a task
• High- and low-resolution figures and images (inline and in a simpletable)
• Video streaming examples

Vector graphics in figures
In this part of the test bed, various illustrations that have both low (png) and high resolution vector graphics (svg's) are added
to test the capability of our outputs with regard to illustrations. These illustrations tend to display one per page.

The following illustrations outline the process:

3
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High Resolution

Figure 5. Here's how to properly disconnect the cables
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Figure 6. Here's how to properly connect the rails (Landscape)

2
4

Illu
stratio

n
 an

d
 v

id
e

o
 te

stin
g



Long-term store
(hardware)

Real-time & Historical 
Business Insights

Streaming Data Platform

Pravega
Store

Apache Flink
Engine

Management
plane/UI

Kubernetes
container environment

Compute & Tier 1 store
(reference hardware & software)

Pravega applications

HIGH RESOLUTION

Figure 7. Flowchart for streaming data (landscape)
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HIGH RESOLUTION

Figure 8. PDU Gen 44 rack power strips
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Low-resolution screenshots in a task
This topic tests the use of mostly low resolution graphic screenshots inside a task topic. Placing the images in various parts of
the task.

Prerequisites

Before you can review your virtual environment using vCloud Director, you must first complete the configuration and setup
tasks.

About this task

vCloud Director provides a dashboard with multiple screens for viewing the status of many aspects of your virtual datacenter.

Steps

Accessing vCloud Director Dashboard

1. Enter the URL provided for your vCloud Director and click the vCloud Director logo in the upper left of the screen to
access the dashboard.

The dashboard displays.

Figure 9. vCloud Director dashboard

2. Choose the hamburger menu and select Datacenters to see the Virtual Datacenter screen
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Figure 10. Virtual Datacenter screen

This screen shows the resources, applications, CPU, memory and storage particulars of this application.

3. Click any item to drilldown and see more information.

Option Description

CPU Provides CPU specifics

Memory Gives detail of memory usage

Storage Provides storage usage and policy information
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Figure 11. Datacenter storage details

Results

This interface provides detailed information on every level.

Next steps

Return to the vCloud Director dashboard.

High- and low-resolution figures and images (inline
and in a simpletable)
This tests images of various sizes, inline and in figures, and also in tables

Smaller images inline with text

Here is some samples of various sized images inline with text.

This is a small icon  inline with this text.

This is a bit larger button inline with the text.

This is an even larger icon inline with the text.

Larger images (not in figures)

This is a larger image (not inline)
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Some smaller images in a simpletable:

Inflorescence
types

Description of types of inflorescence Examples of various inflorescence in images

Solitary Flowers (or heads) borne singly on isolated stems or arising
individually from leaf axils. Not part of a larger group.
(images shown in column two are JPGs)

Raceme A simple, indeterminate inflorescence consisting of stalked
flowers attached to a central stem and forming a more or
less elongated cluster. The stalk of a flower is termed a
pedicle and pedicled flowers are implied by the term
raceme when used alone in the specific sense.

Spike An indeterminate inflorescence consisting of stalkless
flowers attached to a central stem, generally forming a
highly elongated cluster. A raceme of stalkless flowers.

Corymb An indeterminate inflorescence forming a convex or flat-
topped cluster, essentially a contracted raceme. Typically
flowers arise from a central axis on stalks (pedicles) of
different lengths that bring them all to near the same
height. The term is also applied to racemes of similar shape
with branching pedicles. The outermost flowers generally
open first.
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Inflorescence
types

Description of types of inflorescence Examples of various inflorescence in images

Umbel An branched inflorescence forming a convex or flat-topped
cluster in which all the pedicles are nearly the same length,
and appear to originate near a single point (like the spokes
of an umbrella). Many umbels are actually highly contracted
racemes, though the term is frequently used with
determinate forms as well. Umbels can be compound, that
is an umbel of umbels. The form is characteristic of the
parsely family (apiaceae), which was formerly known as
umbelliferae.

Images in a regular table

The following standard DITA CALS tables contain images to show what happens when images are added to a standard table.

This is an Apply button that applies changes made in the application.

This is an Add button that allows you to add new objects in the application.

This is a file folder icon that denotes a location in the storage where objects can be located.

This table shows large images in a table:
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Object (these images are sized down to ... 300 px) Description

2

1

HIGH RESOLUTION

Connecting rails to a rack appliance
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Object (these images are sized down to ... 300 px) Description

Height
1991.6 mm
(199.16 cm, 78.4 in.)

Depth
998 mm
(99.8 cm, 39.3 in.)

Width
600 mm
(60 cm, 23.5 in.)

Rear access
910 mm
(91 cm, 36 in.)

Front access
1070 mm
(107 cm, 42 in.)

Power cord
length
4.5 m 
(15 ft)

Note: Systems with a front door 
are 55 mm (5.5 cm, 2.2 in.) deeper.

High Resolution

Titan rack setup
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Object (these images are sized down to ... 300 px) Description
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Warnado server front-view
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Video streaming examples
Shows how video streaming to Brightcove and YouTube works.

YouTube video streaming

The following video is an example of streaming YouTube content from within a DITA topic using the <object> element.

YouTube Video

PowerEdge Video 

NOTE: YouTube video streaming is no longer the recommended method and is deprecated in favor of Brightcove.

BrightCove video streaming

The following video is an example of streaming from Brightcove within a DITA topic using the <object> element

Brightcove Video

PowerEdge Video 
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Linking and Tables
Introducing linking and tables.

Topics:

• Linking testing
• Tables testing

II
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Linking testing
This chapter contains the following sections:

Topics:

• Testing static cross-references (xref elements) external links and related-links
• About three-column relationship tables
• About two-column relationship tables
• Types of link relationships

Testing static cross-references (xref elements)
external links and related-links
This topic tests static cross-reference links

● Link to a <fig> element Three-column links produced on page 40
● Link to a <table> element Linking values available on page 49
● Link to a particular <step> element in a list of steps 2 on page 43
● Link to a topic directly (not choosing a bookmark) About two-column relationship tables on page 44

These are external link examples

● Link to an external website like https://www.dell.com/support/home/en-us
● Link to an external website using an alternate text reference Dell Support website
● Link to a mailto reference Email the Information Architect

Related information

About three-column relationship tables on page 38

About two-column relationship tables on page 44

About three-column relationship tables
These topics are here to test three-column relationship tables (notice the links that are segregated into Related Tasks, Related
Concepts and Related References sections.)

Test what kind of link works ....

To provide links between topics, DITA instead has a feature called relationship tables (also known as reltables). Simply put, you
specify links between topics in special tables that appear in a ditamap. When you generate output, the links for each topic
appear in a titled subsection at the end of the topic.

Relationship tables cause links to appear at the end of referenced topics in the following outputs:

● PDF A4 Online

● HTML5 Web Help

● HTML5 Single File

● Simple XHTML

● Support Site Posting

NOTE: To explicitly prevent relationship tables from showing links in PDF, add the print="no" attribute to the <reltable>

element.

4
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Three-column relationship tables look like this:

Figure 12. Example three-column relationship table

When this relationship table is rendered, it produces links in three separate related link sections, as shown in (a hardcoded link
like this one should not be used in regular practice. This is added to illustrate and test hardcoded links) Three-column links
produced on page 40
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Figure 13. Three-column links produced

The related links shown below are a result of a three column relationship table added to a map in this publication.

NOTE: The topicref for this topic in the relationship table has a linking attribute set to sourceonly, so while it links to other

topics, no topics with link back to it from the relationship table.

40 Linking testing



Related concepts

Understanding collection-type attributes on page 44

Related references

Types of link relationships on page 49

Related tasks

Populating a three-column relationship table on page 43

Configuring a three-column relationship table on page 42

Adding a three-column relationship table using XMetaL on page 41

Adding a three-column relationship table using XMetaL

These topics show how three-column reltables work.

Prerequisites

First, determine what links you want to occur between topics and create a new ditamap to hold your relationship table. If you do
not currently have a ditamap in your publication, create a new (blank) ditamap and use drag and drop in Tridion Docs Publication
Manager to add the blank ditamap to your publication. This is typically added in the first chapter, but can reside in any chapter
or appendix within your publication.

About this task

You can create or edit three-column relationship tables in ditamaps using XMetaL. Relationship tables create links between
topics

Steps

1. In the Publication Manager Content tab, right click the ditamap that either currently has the relationship table in it, or to
which you want to add a relationship table, and choose Check Out with... and choose XMetaL Author from the list.
The ditamap will be checked out to XMetaL for editing.

2. If you are adding a new relationship table, click into the body of the map (after the title element if one exists) and choose
Table > Insert Relationship Table. The Insert Relationship Table dialog box displays.

Figure 14. Insert Relationship Table dialog box

3. Optionally add a title, then choose an option from the Columns drop down. To add a three-column relationship table, choose
Task, Concept, Reference.

4. Enter a number of rows, depending upon the number of separate relationships you intend to add. This defaults to 10, but you
can change the default.

5. Click Ok to add the relationship file.
This will add a blank three-column relationship table like the following.

Linking testing 41



Figure 15. Blank three-column relationship table with appopriate colspec type attributes

Next steps

The links below are added as a result of a three-column relationship table added in a map in your publication.

Related concepts

Understanding collection-type attributes on page 44

Related references

Types of link relationships on page 49

Related tasks

Populating a three-column relationship table on page 43

Configuring a three-column relationship table on page 42

Adding a three-column relationship table using XMetaL on page 41

Configuring a three-column relationship table

These topics help illustrate relationship table linking

About this task

Once you create your three-column relationship table, you must decide if you want links between topicrefs, in any particular cell,
to reciprocally link between other topicrefs in the same cell. If so, you must add a topic group with a collection-type set to
family. Here's how

Steps

1. In the Publication Manager Content tab, right click the relation in the relationship table (such as Relation task) and select
Add Within > Topic Group.

2. Enter a navigation title, set Collection type to Family, and click OK.

Example

Add topics to the family, right-click the new topic group and select Add Within > Topic Ref. Browse to the topic and insert it.

The links shown below are added to this topic by a three-column relationship table added to the publication
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Related concepts

Understanding collection-type attributes on page 44

Related references

Types of link relationships on page 49

Related tasks

Populating a three-column relationship table on page 43

Adding a three-column relationship table using XMetaL on page 41

Configuring a three-column relationship table on page 42

Populating a three-column relationship table

These topics help to illustrate relationship table linking.

Prerequisites

Before you can populate your relationship table it must have been created.

About this task

To populate your relationship table, you can easily copy and paste existing topicrefs from other parts of your publication in
Publication Manager. Here's how.

Steps

1. Open your publication, that contains a ditamap with a relationship table, in Publication Manager.

2. Expand the bookmap chapters and navigate to the topicrefs for the various topics you wish to add to certain cells of your
relationship table.

NOTE: By default, a relationship table creates reciprocal links between topics that are linked to in the same row, but

different columns of the relationship table.

3. Click on the topicref you want to copy to a cell of the reltable. Right-click and choose Copy.

4. Click into the appropriate cell of the reltable (under Relation task, Relation reference or Relation concept, depending
upon what type of topic you are adding to the cell).

5. Right-click and choose Paste.

Results

The topicref will be added to the relationship table and appropriate links will be added automatically.

Next steps

This is a great way to add topicrefs because it helps ensure that the copied topicrefs actually exist in the publication. While the
transforms will ignore topicrefs in a relationship table that do not exist in the publication, that situation will cause background
errors in Publication Manager that can prevent you from releasing an output or freezing the baseline.

Related concepts

Understanding collection-type attributes on page 44

Related references

Types of link relationships on page 49

Related tasks

Configuring a three-column relationship table on page 42

Adding a three-column relationship table using XMetaL on page 41

Populating a three-column relationship table on page 43
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Understanding collection-type attributes

These topics are here to show how relationship tables work, this topic is also added to the publication twice (using a copy-to
topicref) to show how copy-to attributes can be used to create two copies of the same topic in different parts of a publication
and manage linking to the appropriate version in the navigation.

There are several collection-type attributes that can be used. Here is a table that outlines what each might be used for (and
whether the particular collection-type attribute is supported at Dell.

Collection-type
attribute

What it does (and whether it is supported at Dell)

family If the collection-type attribute is set to 'family' then reciprocal links are created among all topicrefs
that reside inside the element to which the collection-type is applied. Typically collection-type is
applied to a topic group. This is supported in a wide range of outputs at Dell.

sequence If the collection-type attribute is set to 'sequence' then previous and next links are created for all
topicrefs that reside inside the element to which the collection-type is applied. Typically collection
type is applied to topic group. This is only supported for simple XHTML outputs. It makes no sense
for PDF, HTML5 Single file because they are already continuous outputs. As for HTML5 Web Help,
there are previous and next navigation included by default.

tree Not supported at Dell

choice Not supported at Dell

unordered Not supported at Dell

Related references

Types of link relationships on page 49

Related tasks

Populating a three-column relationship table on page 43

Configuring a three-column relationship table on page 42

Adding a three-column relationship table using XMetaL on page 41

About two-column relationship tables
These topics are here to test two-column relationship tables (notice the links that are commbined into a Related Information
section)

Two-column relationship tables look like this:

Figure 16. Example two-column relationship table

When this relationship table is rendered, it produces links in one Related information section at the end of each topic.
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Figure 17. Two-column links produced

The related links shown below are a result of a two-column relationship table added to a map in this publication.

Related information

Adding a two-column relationship table using XMetaL on page 45

Configuring a two-column relationship table on page 47

Populating a two-column relationship table on page 47

Types of link relationships on page 49

Adding a two-column relationship table using XMetaL

These topics show how two-column reltables work.

Prerequisites

First, determine what links you want to occur between topics and create a new ditamap to hold your relationship table. If you do
not currently have a ditamap in your publication, create a new (blank) ditamap and use drag and drop in Tridion Docs Publication
Manager to add the blank ditamap to your publication. This is typically added in the first chapter, but can reside in any chapter
or appendix within your publication.
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About this task

You can create or edit two-column relationship tables in ditamaps using XMetaL. Relationship tables create links between topics

Steps

1. In the Publication Manager Content tab, right click the ditamap that either currently has the relationship table in it, or to
which you want to add a relationship table, and choose Check Out with... and choose XMetaL Author from the list.
The ditamap will be checked out to XMetaL for editing.

2. If you are adding a new relationship table, click into the body of the map (after the title element if one exists) and choose
Table > Insert Relationship Table. The Insert Relationship Table dialog box displays.

Figure 18. Insert Relationship Table dialog box

3. Optionally add a title, then choose an option from the Columns drop down. To add a two-column relationship table, choose
Custom (2 blank columns).

4. Enter a number of rows, depending upon the number of separate relationships you intend to add.

5. Click Ok to add the relationship file.
An empty relationship table will be created with two columns. the table will be added with two columns, but the type
attribute will not be automatically set in the header rows.

6. Set the type attribute by clicking in each of the header rows, place your cursor in the type attribute of the attribute
inspector and type the word topic
This will add a blank two-column relationship table like the following.

Figure 19. Blank two-column relationship table with appropriate colspec type attributes
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Next steps

The links below are added as a result of a two-column relationship table added in a map in your publication.

Related information

Adding a two-column relationship table using XMetaL on page 45

Configuring a two-column relationship table on page 47

Populating a two-column relationship table on page 47

Types of link relationships on page 49

About two-column relationship tables on page 44

Understanding collection-type attributes on page 48

Configuring a two-column relationship table

These topics help illustrate relationship table linking

About this task

Once you create your two-column relationship table, you must decide if you want links between topicrefs, in any particular cell,
to reciprocally link between other topicrefs in the same cell. If so, you must add a topic group with a collection-type set to
family. Here's how

Steps

1. In the Publication Manager Content tab, right click the relation in the relationship table (such as Relation topic) and select
Add Within > Topic Group.

2. Enter a navigation title, set Collection type to Family, and click OK.

Example

Add topics to the family, right-click the new topic group and select Add Within > Topic Ref. Browse to the topic and insert it.

The links shown below are added to this topic by a two-column relationship table added to the publication

Related information

Adding a two-column relationship table using XMetaL on page 45

Configuring a two-column relationship table on page 47

Populating a two-column relationship table on page 47

Types of link relationships on page 49

About two-column relationship tables on page 44

Understanding collection-type attributes on page 48

Populating a two-column relationship table

These topics help to illustrate relationship table linking.

Prerequisites

Before you can populate your relationship table it must have been created.

About this task

To populate your relationship table, you can easily copy and paste existing topicrefs from other parts of your publication in
Publication Manager. Here's how.

Steps

1. Open your publication, that contains a ditamap with a relationship table, in Publication Manager.

2. Expand the bookmap chapters and navigate to the topicrefs for the various topics you wish to add to certain cells of your
relationship table.
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NOTE: By default, a relationship table creates reciprocal links between topics that are linked to in the same row, but

different columns of the relationship table.

3. Click on the topicref you want to copy to a cell of the reltable. Right-click and choose Copy.

4. Click into the appropriate cell of the reltable (under Relation topic).

5. Right-click and choose Paste.

Results

The topicref will be added to the relationship table and appropriate links will be added automatically.

Next steps

This is a great way to add topicrefs because it helps ensure that the copied topicrefs actually exist in the publication. While the
transforms will ignore topicrefs in a relationship table that do not exist in the publication, that situation will cause background
errors in Publication Manager that can prevent you from releasing an output or freezing the baseline.

Related information

Adding a two-column relationship table using XMetaL on page 45

Configuring a two-column relationship table on page 47

Populating a two-column relationship table on page 47

Types of link relationships on page 49

About two-column relationship tables on page 44

Understanding collection-type attributes on page 48

Understanding collection-type attributes

These topics are here to show how relationship tables work, this topic is also added to the publication twice (using a copy-to
topicref) to show how copy-to attributes can be used to create two copies of the same topic in different parts of a publication
and manage linking to the appropriate version in the navigation.

There are several collection-type attributes that can be used. Here is a table that outlines what each might be used for (and
whether the particular collection-type attribute is supported at Dell.

Collection-type
attribute

What it does (and whether it is supported at Dell)

family If the collection-type attribute is set to 'family' then reciprocal links are created among all topicrefs
that reside inside the element to which the collection-type is applied. Typically collection-type is
applied to a topic group. This is supported in a wide range of outputs at Dell.

sequence If the collection-type attribute is set to 'sequence' then previous and next links are created for all
topicrefs that reside inside the element to which the collection-type is applied. Typically collection
type is applied to topic group. This is only supported for simple XHTML outputs. It makes no sense
for PDF, HTML5 Single file because they are already continuous outputs. As for HTML5 Web Help,
there are previous and next navigation included by default.

tree Not supported at Dell

choice Not supported at Dell

unordered Not supported at Dell

Related information

Adding a two-column relationship table using XMetaL on page 45

Configuring a two-column relationship table on page 47

Populating a two-column relationship table on page 47

Types of link relationships on page 49
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Types of link relationships
These topics help illustrate relationship table linking.

Topicrefs added to relationship tables can have an attribute called 'linking' added to them. The linking attribute can limit or
change how links created by that relationship table work. Here's a table that describes each possible linking attribute and how it
affects the links.

Table 1. Linking values available 

linking value How it affects linking to or from that topic

normal You do not have to set linking to normal. This is the default
value and it creates a reciprocal link to and from the two
related topics.

targetonly A topic can only be linked to and cannot link to other topics.

sourceonly A topic cannot be linked to but can link to other topics.

none A topic cannot be linked to or link to other topics. Better to
just omit the topic from the relationship table rather than
setting this option.

NOTE: The topicref to this topic in the relationship tables has the linking attribute set to targetonly, so you should NOT see

links below this note generated by a relationship table, even though you can link to this topic from other topics.

Linking testing 49



Tables testing
This chapter contains the following sections:

Topics:

• Simple table element
• Table element
• Properties table element
• Totally tabular (abbreviated)

Simple table element
The <simpletable> element is used for tables that are regular in structure and do not need a caption.

Extension Definition

.xml eXtensible Markup Language

.html Hyper Text Markup Lanaguage

.jpeg Joint Photographic Experts Group

.png Portable network graphic

.rtf Rich Text Format

The following simple table has keycol="1" set on it, which should cause the items in the first column to appear bold.

Term Categorization Definition

Widget Noun Thing that is used for something.

Drop Verb What you do when you try to move the widget.

Frustration Noun What you feel when you drop the widget.

Table element
The <table> element organizes arbitrarily complex relationships of tabular information. The first example also illustrates
footnotes, and footnote cross-references.

Table 2. Investment client roster 

ID Name Email Investments

231 Albert Master albert.master@gmail.com Bonds

210 Alfred Alana aalan@gmail.com Stocks

256 Alison Smart asmart@biztalk.com Real estate

211 Ally Emery allye@easymail.org Stocks

235 Benson Stewarta benstew@mycorp.com Bonds, real estate

226 Angus Robinsa angus.robins@hotmail.com Stocks, bonds

a. Managing partner of Dewey, Cheatem, and Howe.
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The following table is exactly the same with the outputclass attribute set to "pagewide".

Table 3. Investment client roster (pagewide) 

ID Name Email Investments

231 Albert Master albert.master@gmail.com Bonds

210 Alfred Alan aalan@gmail.com Stocks

256 Alison Smart asmart@biztalk.com Real estate

211 Ally Emery allye@easymail.org Stocks

235 Benson Stewart benstew@mycorp.com Bonds, real estate

226 Angus Robins angus.robins@hotmail.com Stocks, bonds

Properties table element
The <properties> element gives a list of properties for the subject of the current topic, for example whether a class is public or
protected.

Type Value Description

RGB 0, 0, 0 Specify color using a red, green, and blue color model.

CMYK 0, 0, 0, 0 Specify color using cyan, magenta, yellow, and black color model.

HSB 0, 0, 0 Specify color using hue, saturation, and brightness color model.

Another example of a properties table.

Property Type Description

id string Provides the system ID for the zone. In a POST request, this value is the ID that refers
to the item in the collection item resource path.

all_auth_providers Boolean Enables all authentication providers that are available.

all_smb_shares Boolean Enables all SMB shares that are available.

alternate_system_provider string Provides an alternate system provider.

auth_providers array Provides the list of authentication providers used on this zone.

cache_size integer Specifies the maximum size of zone in-memory cache.

home_directory_umask integer Provides the permissions set on automatically created user home directories.

local_provider Boolean Enables the local provider.

map_untrusted string Maps untrusted domains to the NetBIOS domain during authentication.

name string Provides the zone name.

netbios_name string Provides the NetBIOS name.

skeleton_directory string Provides the skeleton directory that is used for user home directories.

smb_shares array Provides the list of SMB share names available within this zone.

system Boolean Indicates whether the zone is built-in.

system_provider string Provides the system provider for the zone.

user_mapping_rules array Provides the current ID mapping rules.

zone_id integer Provides the zone ID on the system.
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Totally tabular (abbreviated)
Testing tables requires comprehensive testing of many attribute settings. This topic tests a wide range of table-based settings,
as described before each of the following tables.

Prerequisites

Testing a table in the Pre-requisite section of a task. This table has these characteristics:

● All borders explicitly turned on
● Horizontal alignment in cols set to Left
● No col width set
● Heading row
● Title

Table 4. Flower anatomy 

Anatomy element Description Etymology

Anther The pollen-bearing body of the stamen,
usually relatively compact, and
supported at the end of the narrow
filament.

French meaning "medicine extracted
from the flower"

Filament A thin element that supports the Anther. Latin for "thread"
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Table 4. Flower anatomy (continued)

Anatomy element Description Etymology

Stigma The outer perianth of a flower
representing the female reproductive
part.

Greek for "mark made by pointed object"

Pedicel The stalk of an individual flower Latin for "small foot"

Sepals (Calyx) Usually green, sepals typically function
as protection for the flower in bud, and
often support for the petals when in
bloom.

Greek for "husk or wrapping"

Petals (Corolla) Modified leaves that surround the
reproductive parts of a flower.

Latin for "foot"

Pistil Expanded basal portion of the stigma. French for "seed bearing organ"

Stamens Combined filament and anther is called
the stamen

Latin for "thread"

About this task

Testing a table in a Context section of a task. This table has these characteristics:

Testing a table in the Pre-requisite section of a task. This table has these characteristics:

● Frame set to all, all other colsep / rowsep set to 0
● col width set proportionally as follows: col1 - 1*; col2 - 4*
● Heading row
● Title

Table 5. Nautical Instruments 

Instument Name Purpose

Compass Uses the magnetic poles of the earth to find magnetic north.

Sand glass Primitive timepiece used to measure the time (usually 30 seconds at a time) on a voyage

Cross staff Early sextant, consists of a wooden rod with a sliding crosspiece used for measuring the altitude of a
star

Lead line Measuring tool designed to assess the depth of the water and take a sample of the ocean floor

Nocturnal Device used to tell time bu siting Polaris and determining its relation to other stars

Quadrant Instrument for measuring altitude of celestial bodies, consisting of a 90° graduated arc with a
movable radius for measuring angles

Astrolabe Inclinometer used to determine the latitude of a ship at sea by measuring the sun's noon altitude
(declination)

Steps

1. The first step is to create a table, perhaps it contains some poetry

Testing table in an <info> element of a step. This table has these characteristics

● Frame set to topbot
● colwidth set proportionally col1 - 2*; col2 - 1*; col3 - 1*
● No heading row
● No title

so much depends
upon
a red wheel
barrow

William Carlos Williams The Red Wheelbarrow
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glazed with rain
water
beside the white
chickens

April is the cruellest month, breeding
Lilacs out of the dead land, mixing
Memory and desire, stirring
Dull roots with spring rain.
...

T.S. Eliot The Waste Land

Two roads diverged in a yellow wood,
And sorry I could not travel both
And be one traveler, long I stood
And looked down one as far as I could
To where it bent in the undergrowth;
...

Robert Frost The Road Not Taken

2. Next, try a table with just a outer border, maybe to surround some outer limits of the imagination ...

Testing table in an <stepresult> element of a step. This table has these characteristics

● Frame set to all
● No inner borders turned on
● No heading row
● Title

Table 6. Outer limits 

From the perspective of an Earthling, outer space is a zone
that occurs about 100 kilometers (60 miles) above the
planet, where there is no appreciable air to breathe or to
scatter light. In that area, blue gives way to black because
oxygen molecules are not in enough abundance to make the
sky blue.

No one knows exactly how big space is.

54 Tables testing



DITA reference
This appendix contains the following sections:

Topics:

• Choosing a topic type
• Favorite elements
• Finding comprehensive DITA information

Choosing a topic type
DITA has different topic types, here's how to choose between them.

Three main types

DITA includes three main topic types: Task, Concept and Reference.

Tasks Used to describe how to perform a procedure

Concepts Present descriptive information so the reader can understand the background and context of a subject

Reference Provides detailed facts, often in a table

The DITA standard defines how each topic type is structured. Every one contains some common elements, like Title, Prolog (for
metadata like audience, category, keywords), Short Description, as well as some that are unique. Tasks, for instance, consist of
a series of <step>s contained inside a <taskbody> element, which also contains tags to define prerequisite, context and result.
Reference has <refbody>, for presenting information in a table.

Favorite elements
Often used DITA elements and the details.

Periodic table of DITA elements

Element Description

<title> The <title> element contains a heading or label for the main parts of a topic: the topic as a whole,
sections, examples, and labelled content such as figures and tables. The element also can be used to
provide a title for a map or a relationship table; when used in a relationship table, the title typically is used
as a authoring convenience and is not rendered for display to an end user.

<shortdesc> Occurs between the topic title and the topic body, as the initial paragraph-like content of a topic. The
short description, which represents the purpose or theme of the topic, is intended to be used as a link
preview and for searching.

<body>,
<conbody>,
<taskbody> or
<refbody>

Container for the main content of a topic.

<section> Represents an organizational division in a topic. Sections are used to organize subsets of information that
are directly related to the topic.

A
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Element Description

<example> A section with the specific role of containing examples that illustrate or support the current topic.

<related-links> A special section following the body of the topic. After a topic is processed into it final output form, the
related links are displayed at the end of the topic.

<task> Tasks are the main building blocks for task-oriented user assistance. They generally provide step-by-step
instructions that will enable a user to perform a task.

<prereq> Section that documents things the user needs to know or do before starting the current task.

<postreq> Section that documents things the user needs to know or do after finishing the current task.

<result> For a task, this is the expected outcome for the task as a whole.

<context> Provides background information for the task.

<steps> provides the main content of the task topic.

...

Finding comprehensive DITA information
How to find comprehensive DITA information

To find a complete reference for DITA information, you can check out these critical online resources:

Table 7. DITA Reference Information 

What is DITA article An introduction to the OASIS
DITA standard, by one of the
creators and foremost
practitioners.

What is DITA and why should I care? This article provides the
answer some readers are
surely asking, Can you give
me a taste of the "why"
behind DITA?

DITA 1.3 Specification The Darwin Information
Typing Architecture (DITA)
1.3 specification defines a set
of document types for
authoring and organizing
topic-oriented information, as
well as a set of mechanisms
for combining, extending, and
constraining document types.

DITA 1.2 Specification The Darwin Information
Typing Architecture (DITA)
1.2 specification defines a set
of document types for
authoring and organizing
topic-oriented information, as
well as a set of mechanisms
for combining, extending, and
constraining document types.
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SDL reference
This appendix contains the following sections:

Topics:

• Finding comprehensive information about Tridion Docs

Finding comprehensive information about Tridion
Docs
How to find comprehensive information about using Tridion Docs

To find a complete reference for Tridion Docs information, you can check out these critical online resources:

SDL Tridion Documentation The Tridion Docs documentation portal contains information
on how to install, upgrade, implement, troubleshoot and use
Tridion Docs.

IDD Knowledge Base This resource shows information about how we use SDL
Tridion Docs, XMetaL Author Enterprise and DITA to develop
documentation at Dell Technotogies.

Inside Dell Structured Content Knowledge Base This is an interactive site where users can join in the
community and ask and answer questions about Tridion Docs,
XMetaL Author Enterprise, DITA and other aspects of
structured content.

Structured Content How-To Videos (older)

IDD Content Operations Video Gallery

How-To videos can help users better grasp how things are
handled.

SDL Tridion Docs Ideas page This place is where you can suggest, discuss, and vote on
ideas. If you want to create an idea for an other related
product choose the appropriate group.

B
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A

admonition
An act or action of admonishing; providing authoritative counsel or warning. In DITA the term refers to Notes, cautions and
warnings added to the text to ensure important information is heeded.

C

collection-type
There are five collection types in DITA:

unordered A collection of topics where links are generated from parent to children, and from children to parent

family A collection of topics where links are generated from parent to children, from children to parent, and from
sibling to sibling (supported at Dell)

sequence A collection of topics where links are generated from parent to children, from children to parent, and from
child to previous sibling (if applicable) and next sibling (if applicable) (somewhat supported at Dell)

choice Not commonly used, but is intended for situations where the reader needs to select one child topic to
proceed. This might be useful when the output document is an interactive decision-support application

Tree Tree is not supported

conkeyref
A content reference that uses a key instead of a file path.

NOTE: As described in the Introduction to reuse in DITA course, a content reference to an element in another file might

look like this:

<ul conref=domestic_duck_warehouse.xml#domestic_duck_warehouse/nesting_materials">
<li/> </ul>

content reference (conref)
Used to reference content that can be reused. It allows reuse of DITA elements, including topic or map level elements. The value
of the @conref attribute must be a URI reference to a DITA element.

content reference (conref)

D

Darwin Information Typing Architecture
An XML data model for authoring and publishing. It is an open standard that is defined and maintained by the OASIS DITA
Technical Committee.

See also XML DITA

K

keyref
An indirect, late-bound reference to topics, to collections of topics (ditabase), to maps, to referenceable portions of maps, to
non-DITA documents, to external URIs, or to XML content contained within a key definition (keydef) topic reference.

Glossary

Glossary 59



R

raster graphic
ost images you see on your computer screen are raster graphics. Pictures found on the Web and photos you import from your
digital camera are raster graphics. They are made up of grid of pixels, commonly referred to as a bitmap. The larger the image,
the more disk space the image file will take up.

relationship table (reltable)
Table that specifies relationships among topics, based on the familiar table model of rows ( <relrow> ), columns ( <relheader> ),
and cells ( <relcell> ). ... When used in this manner, relationship tables make it easy to determine where related information is
missing or undefined. Relationship tables can be abstracted from the topics to enhance reuse by reducing dependencies.

relationship table (reltable)

V

vector graphic
Unlike JPEGs, GIFs, and BMP images, vector graphics are not made up of a grid of pixels. Instead, vector graphics are
comprised of paths, which are defined by a start and end point, along with other points, curves, and angles along the way. A
path can be a line, a square, a triangle, or a curvy shape. These paths can be used to create simple drawings or complex
diagrams.
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